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Finding Information

Look here: For:

Setup Diagram This document contains complete setup information.

Drivers and The Drivers and Utilities CD contains drivers for your AlO printer.
Utilities CD

Documentation and drivers for your printer may already be installed on your computer
when purchased together from Dell. You can use the CD to uninstall/reinstall drivers or
access your documentation.

Readme files may be included on your CD to provide last-minute updates about
technical changes to your printer or advanced technical reference material for
experienced users or technicians.

Owner's Manual This document contains information about:

Basic usage

Scanning, printing, copying, and faxing
Creative projects

Ink cartridge ordering information
Setup troubleshooting

General troubleshooting

Express Service Express Service Code Number.
Code Number
This label is located on your printer.

M



Dell Support
Website

The Dell Support Website provides several online tools, including:

e Solutions - Troubleshooting hints and tips, articles from technicians, and online
courses

e Upgrades - Upgrade information for components, such as memory

e Customer Care - Contact information, order status, warranty, and repair
information

e Downloads - Drivers
Reference - Printer documentation and product specifications

You can access Dell Support at support.dell.com. Select your region on the WELCOME
TO DELL SUPPORT page, and fill in the requested details to access help tools and
information.
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Understanding the Printer Parts




Use the:

To:

Automatic Document
Feeder (ADF)

Scan, copy, or fax multiple page documents and/or legal sized documents.

Paper support

Load paper into the printer.

ADF input tray

Load original documents in the printer. Recommended for scanning, copying,
or faxing multiple page documents.

ADF exit tray

Pick up your original document after it has gone through the ADF.

Top cover

Access the scanner glass:

e Lift top cover to place or remove items on the scanner glass.
e Scanner glass recommended for heavy weight, delicate, or unusually
sized originals that can not be fed through the ADF.

Paper exit tray

Stack paper as it exits the printer.

Display

Check the printer status or view messages, menus, or settings.

Operator panel

Operate your printer (attached to a computer or unattached). For more
information, see Using the Operator Panel.




Use the:

To:

Printer
(scanner
unit)

e Install or change ink cartridges.
e Lock or unlock the scanner.

Scanner lock

Lock or unlock the scanner.

e Push the scanner lock away from you for unlocking.
e Pull the scanner lock toward you for locking.

NOTE: Lock the scanner if you are moving your printer. Unlock the scanner before use.

Scanner Keep the printer (scanner unit) open when changing ink cartridges or toggling the
support scanner lock.
NOTE: To close the printer (scanner unit) for normal operation: lift the (printer) scanner
unit slightly, press the scanner support to the right, then lower the printer (scanner unit)
until it rests on the main body of the printer.
Express e ldentify your printer when you use support.dell.com or contact technical support.
Service e Enter the Express Service Code to direct your call when contacting technical
Code support. The Express Service Code is not available in all countries.




#  Use the: To:

1 | Power supply connector Supply power to the printer.

2 | Wall jack connector Connect your printer to an active telephone line to send and receive
faxes. Your printer must be connected to this telephone line to receive
incoming fax calls.

NOTE: Do not connect additional devices to the wall jack connector and
do not connect a DSL (digital subscriber line), ISDN (integrated services
digital network), or cable modem to the printer.

3 | Data/fax modem, answering | Remove the plug to connect additional devices, such as a data/fax
machine, and telephone modem, telephone, or answering machine to your printer.
connector
NOTE: Do not connect additional devices to the wall jack connector, and
do not connect a DSL (digital subscriber line), ISDN (integrated services
digital network), or cable modem to the printer.

4 | USB cable connector Connect your printer to a computer.

Setting Up Your Printer

E NOTE: The Dell Personal All-In-One Printer A960 supports the Windows XP and Windows 2000
operating systems.

Follow the instructions on your printer Setup Diagram to install the hardware and software. For setup
troubleshooting, see Setup Problems.

You can use the Dell™ AIO Printer A960 to do a variety of things. A few important things to note:

e If your printer is attached to a computer, you can use either the printer operator panel or the printer
software to create your projects.

e You do need to attach your printer to a computer to scan.
e You do need to attach your printer to a computer to print.
e You do not need to attach your printer to a computer to make photocopies.

e You do not need to attach your printer to a computer to send faxes.

ﬁ NOTE: The printer must be connected to a telephone line for faxing to function (attached to a
computer or unattached).

Installing the Operator Panel

The following instructions apply only if you received an additional language operator panel with your printer.



1. Remove the operator panel (if one is installed).

2. Choose the correct operator panel for your language.

3. Position the clips on the printer, and then press down.

Using the Operator Panel

The operator panel buttons help you scan, copy, fax, and customize documents. When Power is lit, the
printer is on. You can select a mode from the Mode area, select or change settings using several of the
buttons, and initiate a scan, copy, or fax from the Start area on the far right.
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Use the:

Mode area
Start area
Power

Stop/Clear (Cancel)

Copy

Scan

Fax

Number of Copies

Quality

Lighter/Darker

Select

Speed Dial

A keypad number or
symbol

To:

Select a Mode (scan, copy, or fax).

Start a color or black and white scan, copy, or fax job.
Turn your printer on or off.

e Cancel a scan, print, or copy job in progress.

e Clear a fax number or end a fax transmission and return the display to
the fax default.

e Exit a menu.

e Clear current settings and return to default settings.

Enter copy mode.

NOTE: This button is lit when the printer is in copy mode.

Enter scan mode (possible when the printer is attached to a computer).

NOTE: This button is lit when the printer is in scan mode.

Enter fax mode. The printer can receive a fax while in any mode.

NOTE: This button is lit when the printer is in fax mode.
Specify a number (1-99) of photocopies.

e Select from the following copy qualities: Quick, Normal, Better, or
Best.

e Select a fax resolution: Standard, Fine, Superfine, or Ultrafine.

e Select a scan resolution when the printer is attached to a computer.

Lighten or darken a photocopy or fax.

Choose the option that appears on the display.

NOTE: If you hold down the Select button, the button acts as a paper feed.

Use the speed dial feature while the printer is in fax mode.

NOTE: If you press Speed Dial when your printer is in copy or scan mode,
the printer automatically switches to fax mode.

e |In fax mode:
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Redial/Pause

Color

Black

Display

Reduce/Enlarge

Options

(s

Enter fax numbers.

Get through an automated answering system.

Select letters when creating a Speed dial list.

Type numbers to enter or edit the date and time shown on the printer
display.

e In copy mode:

Select the number of photocopies you want to make.

e Redial the last number entered when the machine is in fax mode.
Insert a three-second pause in the number to be dialed.
Enter a pause only when you have already begun entering the
number. Press - to insert a pause before number dialed.

NOTE: If you press Redial/Pause when your printer is in copy or scan
mode, the printer automatically switches to fax mode.

Start a color copy, fax, or scan job.

NOTE: In the Mode area, make sure the mode you want is lit.

Start a black and white copy, fax, or scan job.

NOTE: In the Mode area, make sure the mode you want is lit.
View printer status, messages, and menus.

Customize the size of your original document by a percentage, Fit to Page,
or to poster size.

Scroll through the list of menu headings (see Operator Panel Menus).

Decrease a number on the display.

e Scroll through a list on the display.

e Add a space when entering/editing text or numbers on the LCD
display, such as speed dial information or fax numbers.

e Increase a number on the display.

e Scroll through a list on the display.

e Backspace when entering text or numbers on the LCD display, such as
speed dial information or fax numbers.

Operator Panel Menus

See the display for:

e Printer status
e Messages

e Menus

Select Copy Mode Menu Items



1. Press Copy to enter the Copy mode.

2. Press Options repeatedly until the menu heading you want appears on the display.
3. Press + or - to scroll through the available menu items.

4. Press Select when the menu item you want appears on the display to save the setting.

From this sub You can:
menu:

BLANK PAPER S| ZE | Specify the size of the paper loaded in the paper support:

Letter
Legal
B5

Ad

A5

A6

3x5
4x6

L

2L

OO0OO0OO0O0O0O0OO0OO0OO

NOTE: For other specialty sizes, see the All-In-One Center.

BLANK PAPER TYPE | Specify the type of paper loaded in the paper support:

Aut 0 Det ect (default)
Pl ai n

Coat ed

Phot o

Transpar ency

Auto Detect optimizes the setting according to the type of paper loaded.

NOTE: For other specialty types, see the All-In-One Center.

REPEAT | VAGE Specify how many photocopies of one image you want on one page:

1 x per page
4 x per page
9 x per page
16 x per page

COLOR Adjust the color intensity of the copy.

ORI G NAL SI ZE Specify the size of the document on the glass. Auto detect is the default.

NOTE: Specify an original size other than Auto Detect to confine the scan area to the
size of the original selected.

CONTENT TYPE Specify the type of document on the scanner glass.



COLLATE- BLACK Collate multiple black and white photocopies.

NOTE: You can collate color photocopies from the All-In-One software.

KEY PRESS TONE Turn on or off the sound that is made when you press an operator panel button. The
options are:

o Of
O Low (default)
O High

Check ink levels.
Change cartridges.
Align cartridges.
Clean cartridges.
Print a test page.

MAI NTENANCE

PONER SAVE Select a time to begin reducing power:

I medi ately

After 10 mn

After 30 m n (default)
After 60 mn

Never

CLEAR SETTI NGS Select when you want your All-In-One to return to the default settings:

O After two nmin
O Never

SET DEFAULTS Set your default settings to:

o Use Factory
O Use Current

LANGUAGE Select a language for all display text.

Select Scan Mode Menu ltems

1. Press Scan to enter the Scan mode.
2. Press Options repeatedly until the menu heading you want appears on the display.
3. Press + or - to scroll through the available menu items.

4. Press Select when the menu item you want appears on the display to save the setting.



From this sub
menu:

ORI G NAL SI ZE

PONER SAVE

CLEAR SETTI NGS

SET DEFAULTS

LANGUAGE

You can:

Specify the size of the document on the scanner glass.

NOTE: Leave this on Auto Detect (default) unless the size of the document you
printed is not satisfactory.

Select a time to begin reducing power:

I mredi atel y

After 10 mn

After 30 m n (default)
After 60 mn

Never

Select when you want your All-In-One to return to the default settings:

e After two ninutes
e Never

Set your default settings to:

e Use Factory
e Use Current

Select a language for all display text.

ﬁ NOTE: The option currently selected is noted with an asterisk (*) on the display.

Select Fax Mode Menu lItems

1. Press Fax to enter the Fax mode.

2. Press Options repeatedly until the menu heading you wants appears on the display.

3. Press + or - to scroll through the available menu items.

4. Press Select when the menu item you want appears on the display to save the setting

In order for faxing to function properly:

e The printer must be connected to an active phone line.

e If you are using the printer software to fax, the printer must be connected to a computer with a USB

cable.

E NOTE: You cannot fax with a DSL (digital subscribe line), ISDN (integrated signature digital network),
or cable modem.

"2 NOTE: You can also use the Fax Utility Software (see Access the Fax Setup Utility) to adjust some of
the printer fax settings.




From this sub
menu:

PENDI NG FAXES

PRI NT REPORTS

You can:
Cancel any faxes that have not been sent.

Print:

O An activity report (the last 40 sent and received faxes)
o A send log

O A receive log

O A settings list (lists settings such as ringer volume)

ANSVWER FAX WHEN | Select how a fax is received.

DELAY UNTI L

ON HOOK DI AL

RI NGER TONE

KEY PRESS TONE

e Automatically:

After 1 ring

After 2 rings

After 3 rings (default)

After 5 rings
e Manually:

Press # on the external phone connected to the All-In-One.
e Fax tone heard:

When an answering machine is connected to the external phone jack on the All-
In-One.

NOTE: For more information, see Receive Faxes Through an Answering Machine.

Enter a specific time to send a fax. For help, see To Delay Sending a Broadcast Fax.

NOTE: Make sure the date and time are entered correctly before you set a specific
time to send a fax.

Press Select to use On Hook Dial and dial the number when you hear a dial tone.

For more information, see On Hook Dial.

Choose a tone for incoming rings:

o Of
O Low (default)
o High

Turn on or off the sound that is made when you press an operator panel button. The
options are:

o Of
O Low (default)
o High



SPEAKER VCOLUME

EDI T SPEED DI AL

EDI T TI ME/ DATE

PERSONALI ZE FAX

BLANK PAPER
SI ZE

BLANK PAPER
TYPE

FAX FORWARD

ADVANCED FAX

MAI NTENANCE

Turn the All-In-One speaker volume (affects All-In-One fax sounds) to:

o Of
O Low (default)
o High

Do these things to your speed dial list:

O Add a number

O Remove a number

O Modify a number or the list
O Print the list

NOTE: For more information, see Speed Dial.

Edit the time and date.

NOTE: Make sure you enter a number into each of the available spaces. For example,
01:00 for 1:00.

Enter your name or the name of your business and your number. This information
appears as a heading to identify you and your fax machine to the fax recipient.

Choose:

O Letter
o A
O Legal

NOTE: If no asterisk (*) is present, a paper size that is not supported by fax has been
selected through the copy menu.

Specify the type of paper loaded in the paper support:

Aut o Detect (default)
Pl ai n

Coat ed

Phot o

Tr anspar ency

Auto Detect optimizes the setting according to the type of paper loaded.

NOTE: For other specialty types, see Print Media Guidelines for the Paper Support.

e Turn this feature off (default).
e Enter a number to forward the fax to.
e Print the fax and forward it.

Press Select to see a menu of advanced fax options. For help, See Select Advanced
Fax Mode Menu ltems.

Check ink levels.
Change cartridges.
Align cartridges.
Clean cartridges.
Print a test page.

NOTE: Some links do not work while a job is in progress.



CLEAR SETTINGS | Select when you want your All-In-One to return to the default settings:

O After two nminutes
O Never

SET DEFAULTS Set your default settings to:

O Use Factory
o Use Current

Fax e O f (so that no status page is printed)
confirmation e Print for all (which prints a status report after each fax you send including
jobs that have errors).
e Print for errors (which prints a status report only after jobs that did not
send). (default)

Fit fax to page e Try to fit (default)
Two pages

Ring pattern Nor mal (default)
Distinctive ring 1 (Double)
Di stinctive ring 2 (Triple)

Any

NOTE: You can choose distinctive rings, if they are available from your local telephone
service.

Language Your language.

Select Advanced Fax Mode Menu ltems

1. Press Fax to enter the Fax mode.

2. Press Options repeatedly until Advanced Fax appears on the display.
3. Press Select.

4. Press + or - to scroll through the available items.

5. Press Select when the menu item you want appears on the display to save the setting.

From this Advanced | You can select:
Fax option:

Redi al attenpts The number of times you want the machine to try again if your fax does not go
through:

O tinmes
time
ti mes (default)
times
times
times

e 6 o6 o o o
ga b wnN PR



Redi al interval

Activity report

Fax footer

Di al i ng net hod

Di al prefix

Scan before dial

Max send speed

Error correction

Country code

The time the machine waits before attempting a fax call again:

(default)

O~NO U~ WNPE
33333333
e i e R R R R

On request (asking for the report to print). (default)
After 40 faxes (which automatically generates a report after 40 faxes
print).

On (if you want the machine to insert the time, date, and page number at
the bottom of each incoming fax). (default)
O f

e Touch Tone (default)

Pul se
Behi nd a PBX (Dial tone detect off) - send a fax without waiting for a dial
tone

None (default)

e Create - you can create an up to 8 character prefix to be added to the

beginning of each number dialed.

No (default)

e Yes - Only works with standard, fine, black and white, or two-page standard

color faxes.

A bps speed:

2400

4800

7200

9600

12000
14400
16800
19200
21600
24000
26400
28800
31200
33600

On (default)
O f

NOTE: Usually, error correction should be on. However, if you are having trouble
sending an overseas fax, for example, turn error correction off.

Argentina
Australia
Austria
Bel gi um
Brazil



Bul gari a
Canada
Chile

Col umbi a
Croatia
Czech Republic
Denmar k
Egypt

Est oni a
Ecuador

Fi nl and
France
Cer many

G eece
Guam
Hong Kong
Hungary

I ndia

I ndonesi a
Irel and

| srael
Italy
Japan
Latvi a

Li t huani a
Luxenbourg
Mal aysi a

Mexi co

Net her | ands
New Zeal and
Nor way
Peopl es Republic of China
Peru

Phi | i ppi nes
Pol and
Por t ugal
Puerto Rico
Ronmani a
Russi a

Saudi Arabia
Si ngapor e

Sl oveni a
South Africa
Spai n

Sweden
Swit zer |l and
Tai wan
Thai | and

Tur key

UAE

UK

USA
Venezuel a
Virgin Islands



E NOTE: The option currently selected is noted with an asterisk (*) on the display.

Understanding the Automatic Paper Type Sensor

Your printer has an automatic paper type sensor that detects these paper types:
e Plain paper
e Coated paper
e Glossy/photo paper

e Transparencies

If you load one of these paper types, the printer detects the paper type and automatically adjusts the paper
type settings.

ﬁ NOTE: Your printer cannot detect the paper size.

To choose the paper size on which you want to print:
1. With your document open, click File -» Print.
2. In the Print dialog box, click Preferences or Properties (depending on your program or operating
system).
The Print Properties screen appears.
3. From the Paper Setup tab, select the paper size you are using.

4. Click OK.

The automatic paper type sensor is on unless you turn it off. If you want to turn it off:
1. W.ith your document open, click File - Print.

2. In the Print dialog box, click Preferences or Properties (depending on your operating system).

The Print Properties screen appears.
3. Click Options.
4. Click Paper Type Sensor Options.
5. Click Allow the Paper Type Sensor to select paper type (default) to clear the setting.

6. Click OK.



To permanently turn it off:

1.

E

Click Start —» Control Panel —» Printers and Other Hardware —» Printers and Faxes (Windows
)éizzk Start » Settings —» Printers and Faxes or Printers (Windows 2000).

Right-click the printer icon.

Click Printing Preferences or Properties.

Click Options or the Printer Settings and then click Paper Type Sensor Options.

Click the box to clear the setting.

Click OK.

Click OK.

NOTE: To temporarily override the automatic paper type sensor for a particular print job, specify a
paper type in the software screen under Specialty Paper.

The basic functions of your printer are the print, copy, scan, and fax functions. First, learn how to load paper
into your printer with the following instructions. Continue with Using the Printer to learn how to print, copy,
scan, and fax.

Loading Paper

1.

Place the paper against the guide on the right-hand side of the paper support.



2. Squeeze and slide the left-hand paper guide to the left edge of the paper.

ﬁ NOTE: Do not force paper into the printer. The paper should be flat against the paper support's
surface and it's right edge should be flush against the right-hand paper guide.

Print Media Guidelines for the Paper Support

Load up to:

Make sure:

100 sheets of plain paper

The paper is loaded vertically against the right-hand side of the
paper support.
The paper guide is against the left edge of the paper.

NOTE: Load letterhead paper into the printer upside down with the
letterhead facing you.

10 envelopes

The print side of the envelopes faces you.

The envelopes are loaded vertically against the right-hand side of
the paper support.

The stamp location is in the upper left corner.

The paper guide rests against the left edge of the envelopes.

You choose to print the envelopes with Landscape orientation.
You select the correct envelope size.

Select the next biggest size if the exact envelope size is not listed,
and set the left and right margins so that your envelope text will be
correctly positioned.




10 greeting cards, index
cards, postcards, or photo
cards

25 sheets of coated, photo, or
glossy paper

10 transparencies

100 sheets of custom size
paper

25 iron-on transfers

20 sheets of banner paper

NOTE: You can load a single envelope into the paper support without
removing plain paper.

The print side of the cards faces you.

The cards are loaded vertically against the right-hand side of the
paper support.

The paper guide rests against the left edge of the cards.

The glossy or coated side of the paper faces you.
The paper guide rests against the left edge of the photo paper.

The rough side of the transparencies faces you.
The paper guide rests against the left edge of the transparencies.

NOTE: You can load a single transparency into the paper support without
removing plain paper.

The print side of the paper faces you.
The paper guide rests against the left edge of the paper.
Your paper size fits within these dimensions:

Width

O 76 mMm - 216 mm
0 3.0in. -8.5in.

Length

0 127 mm - 432 mm
0 5.0in.-17.0in.

You follow the loading instructions on the iron-on transfer packaging.
The blank side of the transfers faces you.
The paper guide is against the left edge of the iron-on transfers.

The banner paper is designed for use with inkjet printers.
You adjust the printer properties.

Load Your Document on the Scanner Glass

1. Open the top cover.



2. Place the item you want to copy face down on the scanner glass in the upper left corner.

3. Close the top cover.




Using the Printer

@ Using the ADF
@ Printing

@ Copying

@ Scanning

@ Faxing

Using the ADF

Load Your Document Into the ADF

You can load up to 50 sheets of your original document (text side up) into the ADF for scanning, copying,
and faxing. The ADF is recommended for loading multiple page documents.

E4 NOTE: The paper exit tray can hold up to 50 sheets of paper.

Print Media Guidelines for the ADF



Load up to: Make sure:

50 sheets of letter size paper e The document is loaded text side up.
e The paper guide is against the edge of the paper.

50 sheets of A4 size paper e The document is loaded text side up.
e The paper guide is against the edge of the paper.

50 sheets of legal size paper e The document is loaded text side up.
e The paper guide is against the edge of the paper.

50 sheets of custom size paper e The document is loaded text side up.
e The paper guide is against the edge of the paper.
e Your paper size fits within these dimensions:

width

0 210.0 mm - 215.9 mm
o 8.27in. - 8.5in.

Length

0 279.4 mm - 355.6 mm
0 11.0in. - 14.0in.

50 sheets of two, three, or four hole pre- e The document is loaded text side up.
punched media e The paper guide is against the edge of the paper.
e Your paper size fits within the dimensions allowable.

50 sheets of edge reinforced three hole e The document is loaded text side up.
copier media The paper guide is against the edge of the paper.
Your paper size fits within the dimensions allowable.

50 sheets of preprinted forms and
letterhead media

The document is loaded text side up.

The paper guide is against the edge of the paper.

Your paper size fits within the dimensions allowable.

You choose a media that absorbs ink well.

You allow the preprinted media to dry thoroughly

before use in the ADF.

e You do not use media printed with metallic ink particles
in the ADF.

e You avoid embossed designs.

E NOTE: Do not load postcards, photo cards, or photo paper into the ADF.

Printing

1. Make sure your computer and your printer are on.
2. Load paper. For help, see Loading Paper.
3. With your document open, click File - Print.

4. To change the printer settings, click Preferences or Properties (depending on the program or
operating system).



5.

6.

On the three tabs along the left side (Quality/Copies, Paper Setup, and Print Layout) of the Print
Properties screen, confirm the selections, and then click OK.

Click OK or Print (depending on the program or operating system).

Print Photos

Load paper. For help loading photo paper, see Print Media Guidelines for the Paper Support.

With your document open, click File - Print.
Click Preferences or Properties.
Select the paper size.

If using photo paper, make sure the glossy side is facing you when you insert the paper into the paper
support.

Click Print.

Remove your photos from the paper exit tray as they are printed to prevent them from sticking
together or smearing.

NOTE: Before putting your prints in a nonadhesive photo album or framing them, allow sufficient time
for the prints to dry thoroughly (12 to 24-hours, depending on the ambient conditions). This will
maximize the life of your prints.

Print Collated Copies

When your printer is attached to your computer, you can print black and white or color collated photocopies.
To print collated photocopies:

1.

2.

Make sure you have paper loaded in the paper support.

Click Start —» All Programs (or Programs) — Dell Printers —» Dell A10 Printer A960 —» Dell All-
INn-One Center.

The All-In-One Main Page appears on your computer screen.

Click See More Copy Settings.

Select the Collate Copies check box.

Click Copy Now.

When you are using your printer without a computer, you can print black and white collated photocopies:

1.

2.

Make sure you have paper loaded in the paper support.

Press Copy.



3.

4.

5.

Press Options repeatedly until Col | ate - Bl ack appears.

Press + to scroll to the amount of pages you want to collate.

Press Select.

Print Last Page First

Make sure you have paper loaded in the paper support.

Click Start —» All Programs (or Programs) — Dell Printers —» Dell A10 Printer A960 —» Dell All-
In-One Center.

The All-In-One Main Page appears on your computer screen.

Click See More Copy Settings.

Select the Print Last Page First check box.

Click Copy Now.

Print Two Images On One Page

You can print two images on one page to save paper or create interesting documents:

1.

2.

Make sure you have paper loaded.

Click Start —» All Programs (or Programs) — Dell Printers —» Dell A10 Printer A960 —» Dell All-
INn-One Center.

The All-In-One Main Page appears on your computer screen.

Click View Saved Images.

From the Productivity Tools menu, click Print two different pictures on one page (2 on 1).

Follow the instructions on your screen.

Print Repeating Images

You can print the same image multiple times, as few as two per page and as many as eight per page, on one
sheet of paper:

1.

2.

Load A4 or letter size paper in the paper support. For help, see Loading Paper.

Click start —» All Programs (or Programs) — Dell Printers — Dell A10 Printer A960 —» Dell All-
INn-One Center.

The All-In-One Main Page appears on your computer screen.

From the Productivity Tools menu, click Repeat an image several times on one page.

Click Preview Now to view vour scanned imaage.



NOTE: If the size of the scan (found in the lower right of the preview window) appears in red, you do
not have the system resources available to perform the scan at the resolution or size you have
selected. To correct this problem, either reduce your resolution or the size of your scan area.

Adjust the dotted lines to fit around the portion of the image you want to print.
Click Printer Settings to select your paper size.
Click OK.

When you are finished customizing your image, click Print Now.

NOTE: When you print multiple images on one sheet of paper in this way, you cannot use
Reduce/Enlarge. Depending on how many images you want to print per page, the printer reduces
them to fit on the page.

Print More Than One Page On a Sheet of Paper

Make sure you have paper loaded in the paper support.

Click start —» All Programs (or Programs) — Dell Printers — Dell A10 Printer A960 —» Dell All-
INn-One Center.

The All-In-One Main Page appears on your computer screen.

From the Productivity Tools area, click More than one page on a sheet of paper.

Follow the instructions on your screen.

Print an Image as a Multi-Page Poster

You can print a poster of an image that you want to enlarge and extend over multiple pages.

Load A4 or letter size paper. For help, see Loading Paper.

Load your document on the scanner glass or into the ADF. For help, see Load Your Document on the
Scanner Glass or Load Your Document Into the ADF.

Click Start —» All Programs (or Programs) — Dell Printers —» Dell AI1O Printer A960 — Dell All-
INn-One Center.

The All-In-One Main Page appears on your computer screen.

Under Productivity Tools, click Print an image as a multi-page poster.

Click Preview Now to view your scanned image.

NOTE: If the size of the scan (found in the lower right of the preview window) appears in red, you do
not have the system resources available to perform the scan at the resolution or size you have
selected. To correct this problem, either reduce your resolution or the size of your scan area.



Adjust the dotted lines to fit around the portion of the image you want to print.
Click Printer Settings to select your paper size.
Select your paper size, and then click OK.

When you are finished customizing your document, click Print Now.

Print a Banner

1.

Place a stack of banner paper (20 sheets or less) on the top cover, and feed in the first sheet.

With your document open, click File —» Print.
Click Preferences or Properties.

From the | Want To menu, click Print a banner.
Follow the instructions on your screen.

Click OK, OK, and then OK again.

NOTE: Once the printer begins printing, wait until you can see the leading edge of the banner exiting
the printer, and then carefully unfold the paper down to the floor in front of the printer.




Copying

You can use your printer to copy using the printer operator panel or the printer software.

Copy Using the Operator Panel

Make sure your printer is on.
Load paper. For help, see Loading Paper.

Load your document on the scanner glass or into the ADF. For help, see Load Your Document on the
Scanner Glass or Load Your Document Into the ADF.

From the Mode area on the operator panel, press Copy to enter copy mode.

If you want to make more than one photocopy, press the numbers on the keypad that correspond with
the number of photocopies you want to make.

From the Start area on the operator panel, press Color to create a color photocopy of your image or
press Black to create a black and white photocopy.
Copyi ng appears on the display.

Copy Using the Printer Software

Make sure your computer and your printer are on.
Load paper. For help, see Loading Paper.

Load your document on the scanner glass or into the ADF. For help, see Load Your Document on the
Scanner Glass or Load Your Document Into the ADF.

Click Start —» All Programs (or Programs) — Dell Printers —» Dell A10 Printer A960 —» Dell All-
INn-One Center.

The All-In-One Main Page appears on your computer screen.

Click See More Copy Settings.

Select a quantity and color for your photocopies.

NOTE: You can also choose a paper size or further customize your copy job on this screen.

Click Copy Now.

Copy Photos

1.

Load paper. For help loading photo paper, see Print Media Guidelines for the ADF.



2. Load your document on the scanner glass or into the ADF. For help, see Load Your Document on the

Scanner Glass or Load Your Document Into the ADF.

E NOTE: Make sure the upper left corner of the front of the photo aligns with the arrow.

3. Click Start -» All Programs (or Programs) — Dell Printers —» Dell A1O Printer A960 — Dell All-
INn-One Center.
The All-In-One Main Page appears on your computer screen.

4. Click Preview Now.

ﬁ NOTE: If the size of the scan (found in the lower right of the preview window) appears in red, you do
not have the system resources available to perform the scan at the resolution or size you have
selected. To correct this problem, either reduce your resolution or the size of your scan area.

5. Adjust the dotted lines to fit around the portion of the image you want to print.
6. From the Copy section, select Photo.

7. Select a copy quantity if making multiple photocopies.

8. To further customize your photo, click See More Copy Settings.

9. When you are finished customizing your settings, click Copy Now.

Scanning

You can use your printer to scan using the printer operator panel or the printer software.

Using the Operator Panel

1. Make sure your computer and printer are on, and the computer is connected to the computer.

2. Load your document on the scanner glass or into the ADF. For help, see Load Your Document on the
Scanner Glass or Load Your Document Into the ADF.

3. From the Mode area on the operator panel, press Scan to put the printer in scan mode.
4. Press + to scroll through the list of possible programs to which you can scan.
5. Press Select when the program to which you want to scan appears.

6. From the Start area on the operator panel, press Black to begin a black and white scan or Color to
begin a color scan.

Using the Printer Software



NOTE: Some programs do not support multiple page scanning.

Make sure your computer and printer are on, and the computer is connected to the computer.

Load your document on the scanner glass or into the ADF. For help, see Load Your Document on the
Scanner Glass or Load Your Document Into the ADF.

Click Start —» All Programs (or Programs) — Dell Printers —» Dell A10 Printer A960 —» Dell All-
In-One Center.
The All-In-One Main Page appears on your computer screen.

Click Preview Now to see your scanned image.

NOTE: If the size of the scan (found in the lower right of the preview window) appears in red, you do
not have the system resources available to perform the scan at the resolution or size you have
selected. To correct this problem, either reduce your resolution or the size of your scan area.

Adjust the dotted lines to fit around the part of the image you want to print.
From the Send scanned image to drop-down menu, select your scan destination.
To further customize your scan job, click See More Scan Settings.

When you are finished customizing your image, click Scan Now.

Scan photos

Make sure your computer and your printer are on, and the printer is connected to the computer.

Place your photo on the scanner glass. For help, see Using the ADF.

NOTE: Make sure the upper left corner of the front of the photo aligns with the arrow.

Click Start —» All Programs (or Programs) — Dell Printers —» Dell A10 Printer A960 —» Dell All-
INn-One Center.
The All-In-One Main Page appears on your computer screen.

Click Preview Now to see your scanned image.

NOTE: If the size of the scan (found in the lower right of the preview window) appears in red, you do
not have the system resources available to perform the scan at the resolution or size you have
selected. To correct this problem, either reduce your resolution or the size of your scan area.

Adjust the dotted lines to fit around the portion of the image you want to print.
From the Send scanned image to drop-down menu, select your scan destination.

To further customize your scan job, click See More Scan Settings.



8. When you are finished customizing your image, click Scan Now.

9. When your document has finished processing, it will open in the program you chose.

Edit Scanned Images

With most graphics programs, you can customize your image.
1. From the Dell All-In-One Center, scan your image to the image editor of your choice.

2. Edit the image using the tools available in your program.

You may be able to:
e Remove red eye
e Crop your image
e Add text to your image

e Adjust the brightness and contrast of your image

For help, see the documentation that came with your graphics program.
Scan Multiple Pages or Images

E NOTE: This feature is only available when scanning from the flatbed scanner.

1. Put the first sheet on the scanner glass.

2. Click Start -» All Programs (or Programs) — Dell Printers — Dell A10 Printer A960 — Dell All-
INn-One Center.
The All-In-One Main Page appears on your computer screen.

3. Select your scan destination from the drop-down box.

4. In the Scan section, click See More Scan Settings

5. Click Display Advanced Scan Settings.
The Advanced Scan Settings dialog box appears.

6. On the Scan tab, select Scan multiple items before output.
7. Click OK.

8. When you are finished customizing your settings, click Scan Now.



E NOTE: You are prompted to put the next item on the scanner glass after the first one scans.

Edit Text Found in a Scanned Document Using Optical
Character Recognition (OCR)

Optical Character Recognition is a software feature that turns a scanned image into editable text within a
word processing program.

1.

Load your document on the scanner glass or into the ADF. For help, see Load Your Document on the
Scanner Glass or Load Your Document Into the ADF.

Click start —» All Programs (or Programs) — Dell Printers — Dell A10 Printer A960 —» Dell All-
INn-One Center.

The All-In-One Main Page appears on your computer screen.

From the Productivity Tools section, click Edit text found in a scanned document (OCR).

Follow the instructions on your computer screen.

When your document has finished processing, it will open in the program you chose.

Edit your document.

Save your document.

Save an Image on Your Computer

1.

Click Start —» All Programs (or Programs) — Dell Printers — Dell A10 Printer A960 —» Dell All-
INn-One Center.

The All-In-One Main Page appears on your computer screen.

From the Productivity Tools section, click Save an image on my computer.

Follow the directions to save an image on your computer.

E-mail a Scanned Image or Document

You can send photographs through e-mail:

Open the top cover.

Place the photograph you want to scan face down on the scanner glass.

Close the top cover.

Click Start —» All Programs (or Programs) — Dell Printers — Dell A10 Printer A960 — Dell All-

In-One Center.
The All-In-One Main Page appears on your computer screen.



5. Click Preview Now.

E NOTE: If the size of the scan (found in the lower right of the preview window) appears in red, you do
not have the system resources available to perform the scan at the resolution or size you have
selected. To correct this problem, either reduce your resolution or the size of your scan area.

6. From the Productivity Tools area, click E-mail an image or document.
7. From the What is being scanned? menu, select Photo.

8. Follow the instructions on the screen to prepare the photograph for e-mail.
9. Click Attach Now.

10. Write a note to accompany the attached photo, and then send it.

Enlarge or Reduce Images or Documents

1. Load paper in the paper support. For help, see Loading Paper.

2. Load your document on the scanner glass or into the ADF. For help, see For help, see Load Your
Document on the Scanner Glass or Load Your Document Into the ADF.

3. Click Start -» All Programs (or Programs) — Dell Printers — Dell A1O Printer A960 — Dell All-
INn-One Center.
The All-In-One Main Page appears on your computer screen.

4. Click Preview Now.

E NOTE: If the size of the scan (found in the lower right of the preview window) appears in red, you do
not have the system resources available to perform the scan at the resolution or size you have
selected. To correct this problem, either reduce your resolution or the size of your scan area.

5. From the Productivity Tools area, select Enlarge or reduce an image.
6. Follow the instructions on the screen to select the size of your new image.

7. When you are finished customizing your image, click Print Now.

Faxing

You can fax using the printer operator panel or the printer software.

E NOTE: You do not need to connect your printer to a computer to send faxes.

In order to fax using the printer software:



e Your computer must have Dell Printer Fax Tools, Classic Phone Tools, or Microsoft Fax Console installed
and configured

O See Using Dell Printer Fax Tools Fax Software to use Dell Printer Fax Tools.

O See Using Fax Console (Windows XP Only) to use Fax Console.

e Your computer must be equipped with a data/fax modem.

e An active telephone line must be connected to the line-in connector of your computer's data/fax
modem. Do not connect the data/fax modem to the printer's wall jack connector. See Wall jack

connector for more information.

ﬁ NOTE: DSL (digital subscriber line), ISDN (integrated services digital network) and cable modems are
not fax modems and are not supported.

Additional devices must be connected to the line-out connector for proper fax operation.

e Your printer must be connected to the computer with a USB cable.

USB cable

computer connector

Y

printer connector

Using Dell Printer Fax Tools Fax Software

Install Dell Printer Fax Tools Fax Software

1. Click the Start —» All Programs (or Programs).

A list of your installed software appears.

2. Check for any entry referring to Classic PhoneTools or Fax Tools. If you have either of these entries,



10.

11.

12.

skip to "Configure Dell Printer Fax Tools Fax Software."

Click on the desktop.

The All Programs window closes.

Insert the Dell Personal All-In-One Printer A960 Drivers and Utilities CD.

An installation window appears.
Click Cancel.
Click Start > My Computer.

Right-click the CD Drive icon.

A drop-down menu appears.

Click Explore.

Double-click the Fax folder.

Double-click the appropriate language folder.

Double-click the Setup icon.

The Installation Wizard appears.

Follow the instructions on your computer screen to complete the installation.

Configure Dell Printer Fax Tools Fax Software

I

NOTE: Fax service is set by default to automatically answer your phone line after two rings if you click
to select the Enable Receive check box. Change these settings as desired.

Click Start - All Programs (or Programs).

Click Dell AIO Printer A960 —» Fax Setup Utility or Classic PhoneTools.

The fax configuration wizard begins.

Click Next.

Read the license agreement, and then click Yes to continue.
Enter your name and company name.

Click Next.

Enter an identifier, phone number, and fax number.



10.

11.

12.

13.

14.

Click Next, click Next, Next, and click Next again.

Click Finish.

Dell Printer Fax Tools fax software launches.

Select your country, enter your area code, and enter any humber you must press first before getting to
an outside line.

Click OK.
Select your location, and then click OK.
Click Next, click Next, select your modem, and click Next again.

Click Next, click Next, and then click Finish.

Using Fax Console (Windows XP Only)

Install Fax Console

Click Start - Control Panel.

Click Add or Remove Programs.

Click Add/Remove Windows Components.

Click to select Fax Services.

Click Next.

If prompted, insert the Microsoft Windows XP CD, and then click OK. Close the Welcome to
Microsoft Windows XP window when it opens.

Click Finish.

Close the Add/Remove Programs window.

Configure Fax Console

1.

Click Start -» All Programs (or Programs) —» Accessories - Communications - Fax —» Fax
Console.

The Welcome to Fax Configuration Wizard appears.

Click Next.

Enter any appropriate information, and then click Next.

Select your data/fax modem in the drop-down menu under Please select the fax device.



5. Select or de-select the Enable Send and Enable Receive check boxes as desired.

6. Click Next.

E NOTE: De-selecting the Enable Send check box prevents you from sending faxes. Selecting the
Enable Receive check box allows you to receive faxes.

7. Enter your TSID information, and then click Next.
8. Enter your CSID information, and then click Next.

9. Click to select Print it on. Use the drop-down menu to the right of this field to select Dell A10O Printer
A960 if you want to print all received faxes.

10. To create an archive copy of each fax, click to select Store a copy in a folder, and then use the
Browse button to select the desired archive location.

11. Click Next, confirm your settings, and click Finish.

Access the Fax Setup Utility

e Click Start » All Programs (or Programs) —» Dell Printers —» Dell AIO Printer A960 —» Fax
Setup Utility

e From the Dell All-In-One Center, click the Maintain/Troubleshoot tab, and then click Display the
Fax Setup Utility.
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The following table describes what you can do from each of the Fax Setup Utility tabs.



On this tab: You can:

Send e Enter your name and fax number.
e Select a maximum send speed and a print quality for outgoing faxes.
e Choose whether to scan the entire document before dialing the number.
e Choose whether to use error correction.
e Select when to print a fax usage report.
e Select when to print a fax activity report.
Receive e Choose whether you want to print a footer (date, time, and page number) on
each page.
e Automatically reduce an incoming fax to fit to the paper size loaded or print it on
two sheets of paper.
e Select whether you want to forward a fax or print it, and then forward it.
Connection/Dialing e Select the number of times you want the machine to redial and the time
between those attempts if the fax cannot be sent on the first try.
e Select the phone line format you want to use (Pulse, Touch-tone, Behind a PBX).
e Enter a dialing prefix.
e Choose how (manually, if fax tones are detected, or after a certain amount of
rings) you want to answer incoming calls.
e Choose a distinctive ring.
Speed Dial Add to, create, or edit the speed dial list.

Group Speed Dial | Create a group number and name and add phone numbers to the group.

Send a Fax

You can send and receive color faxes using the operator panel only. In order to send a color fax from your
printer, the machine to which you are sending the fax must also support color faxes.

You can send faxes using the printer operator panel or the printer software.

Using the Operator Panel

You can use your printer to send color or black and white faxes. You can send and receive A4, legal, and
letter size documents.

1. Make sure your printer is on.

2. Load your document on the scanner glass or into the ADF. For help, see Load Your Document on the
Scanner Glass or Load Your Document Into the ADF.

3. Press Fax.

4. Use the keypad to:

e Enter the fax number, or

e Press Speed Dial, and then



O Press + or - to scroll through the list to find the number you want, or

O Enter a two-digit number (viewable in the upper left of the display).

E NOTE: If you do not have a Speed dial list, but want to create one, see Speed Dial.

5. Press Black or Color.
The printer scans your document and sends your fax to the number you entered.

Using Dell Printer Fax Tools Fax Software

1. Make sure your printer and computer are on.

2. Load your document on the scanner glass or into the ADF. For help, see Load Your Document on the
Scanner Glass or Load Your Document Into the ADF.

3. Make sure your printer is connected to a computer with a data/fax modem and the modem is
connected to an active telephone line.

4. Click Start » All Programs (or Programs) —» Dell Printers —» Dell A1O Printer A960 —» Dell
All-In-One Center.

5. Place the document you want to fax face down under the lid of the printer.
6. From the Productivity Tools section, select Fax an image or document.
7. Select No under Is there more than one page.

8. Click Next.

The document is scanned and Dell Printer Fax Tools launches.

Send Multiple Page Faxes

You can send multiple page faxes using the printer operator panel or the printer software.

Using the Operator Panel

1. Make sure your printer is on and connected to a computer with a data/fax modem and the modem is
connected to an active telephone line.

2. Load your document into the ADF. For help, see Using the ADF.
3. Press Fax.
4. Enter the fax number using the numbers on the keypad.

5. Press Black or Color.



I

NOTE: In order to send a color fax from your printer, the machine to which you are sending the fax
must also support color faxes.

Using Dell Printer Fax Tools Fax Software

10.

11.

Click Start —» All Programs (or Programs) — Dell Printers —» Dell AIO Printer A960 — Dell
All-In-One Center.

Click See More Scan Settings.

Click Advanced.

Click to select Scan multiple items before output (flatbed scanner only).
Click OK.

Select Fax from the Send scanned image to drop-down menu.

Place the document you want to fax face down under the lid of the printer.

Click Preview Now.

A preview of your document appears. Adjust your document and repeat if necessary.

NOTE: If the size of the scan (found in the lower right of the preview window) appears in red, you do
not have the system resources available to perform the scan at the resolution or size you have
selected. To correct this problem, either reduce your resolution or the size of your scan area.

Click Scan Nowv.
Click Yes until all pages you want to fax are scanned, and then click No.

Follow the instructions on your computer screen to send your fax.

Receive Faxes

E

NOTE: Your printer cannot receive soft copy faxes, it can only send them. All incoming faxes print

from your printer.

You can receive faxes using the printer operator panel or the printer software. You can choose to receive
faxes automatically, manually, or through an answering machine.

Receiving Faxes Through the Printer

For information on receiving faxes through the printer, see the following sections.

e Receive Faxes Automatically

e Receive Faxes Manually



e Receive Faxes Through an Answering Machine

Receiving Faxes with Fax Console

Click start —» All Programs (or Programs) —» Accessories - Communications —» Fax.

Click Fax Console.
You are now ready to receive a fax if you selected the Enable Receive check box when configuring Fax
Console.

Receive Faxes Automatically

To reset your printer to automatic answering mode (default):

E

From the operator panel, press Fax.
Press Options until Answer fax when appears.
Press + to scroll through the available options.

Choose After 1 ring, After 2 rings, After 3 rings, or After 5 rings, and then press Select.

When the number of rings that you set is detected, the printer automatically receives your fax.

NOTE: For your printer to receive a color fax, the machine from which you are receiving must also
support color faxes.

Receive Faxes Manually

From the operator panel, press Fax.

Press Options until Answer fax when appears.

Press + to scroll through the available options.

Press Select when Manual - Press # appears on the display.

When it rings, pick up a telephone that is connected to the external jack of the printer and listen for
the fax calling tone.

Press the pound (#) key on the telephone.

Hang up the telephone.

The printer receives your fax.

Receive Faxes Through an Answering Machine



From the operator panel, press Fax.

Press Options until Answer fax when appears.
Press + to scroll through the available options.

When Fax Tone Heard appears on the display, press Select.

When a ring is detected, the answering machine picks up the call.
o If a fax is detected, the printer receives the fax, and disconnects the answering machine.

o If not, the answering machine completes the call.

Print Faxes Using Dell Printer Fax Tools Fax Software

From the main Fax Tools screen, click Configure.
Select General Setup.
Select the Fax tab.

Click the Print received faxes check box, and then click OK.
Incoming faxes automatically go to the printer as they are received.

NOTE: To view all received faxes, click the Fax Inbox button. Click the Fax Outbox button to view a
list of sent faxes.

Print to Fax

The Print to fax feature eliminates the need to print an original document and put it on the scanner glass to
send a fax the conventional way. You can create or receive a soft copy document on your computer and send
a black and white fax of it to someone else.

E

NOTE: You cannot receive soft copy faxes, only send them. All incoming faxes will print from your
printer.

To send a fax from your computer program using the fax modem in your printer:

With your document open, click File —» Print.
In the printer list, select Dell Printer Fax Tools.
Click Print.

To Print to fax, follow the instructions in the program that launches.

NOTE: All faxes sent using the Print to fax feature use the Fine resolution.



Viewing Sent Faxes and Received Faxes

Using Fax Console

1.

2.

Click Start —» All Programs (or Programs) —» Accessories - Communications —» Fax.

Click Fax Console.

Received faxes can be viewed in the Inbox. Sent faxes can be viewed in Sent lItems.

View the Status of a Fax

Using Fax Console

1.

Click Start —» All Programs (or Programs) —» Accessories - Communications - Fax —» Fax
Console.

Click to expand the Fax folder, if necessary.
The following folders appear.:

o Incoming - faxes currently being received

O Inbox - faxes that have been received

O Outbox - faxes scheduled to be sent

O Sent Items - faxes successfully sent
Click the folder of your choice.

In the right pane, click the fax for which you want to view the status, and then click Preferences or
Properties.

Click the General tab and view the Status line.

Click Close when you are finished.

Using Special Fax Features

There are several fax features on your Dell A960 that make sending faxes more efficient.

Speed Dial

To make sending faxes easier, you can enter up to 100 speed dial numbers. You can enter 80 individual fax
numbers and 20 groups that can hold up to five phone numbers each.

Using the Operator Panel



Press Fax.

Press Speed Dial.
The first speed dial number in the list appears.

Scroll through the list using the + or - button or use the keypad to enter the two-digit speed dial
number.

Using the Printer Software

Click Start —» All Programs (or Programs) — Dell Printers —» Dell A1O Printer A960 —» Fax
Setup Utility.

Click the Speed Dial tab.

Follow the instructions on the Speed Dial tab to add a new number to your speed dial list.

Using Your Speed Dial List

1.

E

Press Speed Dial, and then:

O Use the + or - button to scroll through the speed dial list to find the desired fax number, and
then press Fax.

O Press the keypad buttons to enter a two-digit number (viewable in the upper left corner of the
display), and then press Fax.

When the default screen appears, press Options.
Press Select.
Enter the information about when you want your fax to send.

Press Select again, and then press 1 for AM or 2 for PM.
The default screen appears again.

NOTE: You can repeat this process to enter more numbers to which you want to send a delayed fax.

On Hook Dial
1. On the operator panel, press Fax.
2. Press Options repeatedly until On Hook Di al appears.
3. Press Select to make the printer go off hook.
4. Enter the number to which you want to send a fax.
5. Press the keypad numbers to navigate an automated answering system.



6.

Press Black or Color when you are ready to send a fax.

Broadcast Send

If your printer is attached to a computer, you can send a fax of up to 20 pages to as many as five people at

once.

To Send a Broadcast Fax Immediately

Press Fax.

Press Options four times to display Del ay Unti | .

Press + or - to display Do not del ay, and then press Select.

Enter a fax number or press Speed Dial to select numbers from your Speed dial list.

Press Black or Color to send the fax immediately or press Select to enter another fax number.

Press Black or Color to send the fax to both numbers or press Select to enter another fax number.
Continue this procedure until all of the fax numbers (up to five numbers) have been entered.

To Delay Sending a Broadcast Fax

Manually entering a fax number:

On the operator panel, press Fax.

When the default screen appears, press Options until Del ay Until appears.
Press + or - to scroll to Ti ne.

Press Select.

Enter the time you want your fax to send.

Press Select.

If your printer is in 24-hour mode, the screen will return to the default display. If the machine is set to
12-hour mode, press 1 for AM or 2 for PM.

Using the keypad, enter the fax number.

Press Black or Color to send your fax to this number or press Select to enter another fax number
(you can do this up to five times and the delayed fax will be sent to as many numbers as you entered).

NOTE: At the designated time, the fax numbers are dialed and the fax transmitted to all of the
designated fax numbers. If the fax transmission is unsuccessful to any of the numbers on the
broadcast list, the unsuccessful numbers will be tried again at the end of the list.



Understanding the Software

@ Understanding the Printer Software
@ Using the Dell All-In-One Center

@ Using Print Properties

@ Using the Dell Printer Solution Center

@ Using Dell Picture Studio

Understanding the Printer Software

The printer software includes the:

e Dell All-In-One Center-helps you perform various scan, copy, and fax operations and manage your
saved images.

e Print Properties-helps you adjust printing settings.

e Dell Printer Solution Center-provides maintenance and troubleshooting help, provides basic usage
information, and How to's for creating projects.

e Dell Picture Studio-helps you edit your photos.

ﬁ NOTE: Your language may not be supported. If your language is not supported, use the photo editing
software in your Windows operating system.

e Fax Setup Utility-helps you set up your fax settings. For help, see Access the Fax Setup Utility.

Using the Dell All-In-One Center

You can use the Dell All-In-One Center to:
e Select a scan destination.
e Select a photocopy quantity and color.
e Scan, copy, print, fax, and do creative tasks.
e Access troubleshooting and maintenance information.
e Preview images you want to print.

e Manage photos (copy them to folders, print them, do creative copying) using the View Saved Images
tab.



Access the Dell All-INn-One Center

e Click Start » All Programs (or Programs) —» Dell Printers —» Dell AIO Printer A960 — Dell All-

INn-One Center.

The All-In-One Main Page

The All-In-One Main Page consists of four main sections. The following table describes each of the sections.

From this section: | You can:

Scan

e Select a program to send the scanned image to.

e Choose what type of image is being scanned.
e Choose how the scan will be used.

NOTE: Click See More Scan Settings to view all settings.

Copy

NOTE: Click See More Copy Settings to view all settings.

Select the quantity and color of your photocopies.
Select a quality setting for your photocopies.
Adjust the size of the scanned area.

Lighten or darken your photocopies.

Enlarge or reduce your photocopies.

Productivity Tools | Choose from a variety of creative ideas.
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Fax an image or document.

Enlarge or reduce an image.

Repeat an image several times on one page.
Print an image as a multi-page poster.
E-mail an image to a friend.

Save an image on your computer.

Edit text found in a scanned document (Optical Character Recognition).

Modify an image with a photo editor.



Preview section e Select a region of the preview image to scan.
e View an image of what will be printed or copied.

"4 NOTE: For more information about the All-In-One Main Page, View Saved Images Page, or the
Maintain/Troubleshoot Page, click the Help button located in the upper right corner of the screen.

View Saved Images Page

Use the View Saved Images page (accessed from the All-In-One Main Page) to perform tasks with images
that are saved on the computer. The View Saved Images page consists of three sections.

From this You can:

section:

Open with Select a program to send the saved image to.

Print a Copy e Choose the quantity and color of your photocopies.
e Select a quality setting for your photocopies.
e Lighten or darken your photocopies.
e Enlarge or reduce your photocopies.

NOTE: Click See More Copy Settings to view all settings.

Productivity Select from a variety of creative ideas. For a list of creative tasks available from the All-
Tools In-One Main Page, see Productivity Tools.

Maintain/Troubleshoot Page

The Maintain/Troubleshoot page (accessed from the All-In-One Main Page) provides you with direct links to
the Dell Printer Solution Center. Choose from these topics:

e Maintain or fix quality problems
e Troubleshoot printer problems

e Device status and ink levels

e More printing ideas and how to's
e Contact information

e Advanced

e View the software version and copyright information

For more information about the Dell Printer Solution Center, see Using the Dell Printer Solution Center.

Using Print Properties



You can change your printer settings in Print Properties.

Access Print Properties

1. With your document open, click File -» Print.
The Print dialog box appears.

2. In the Print dialog box, click Preferences or Properties (depending on your program or operating

system).

The Print Properties screen appears along with the | Want To menu

Dell AD Printer AB0

fuality/Spesd- Multiple

Print Properties tabs mt "
Use the Quality/Copies, < L
Paper Setup, and Print
Layout tabs to select
the print settings.

To access Print Properties when a document is not open:
1. Click Start —» Printers.

2. Right-click, and then choose Printer Preferences.

The I Want To Menu

The | Want To menu displays when you open Print Properties. It contains a variety of task wizards to help
you select the correct print settings for your project. Close the menu for a full view of the Print Properties

dialog box.

Print Properties Tabs

All of the print settings are on the three main tabs of the Print Properties software. The following table

describes each of the tabs.

Select one of the
projects from the menu
to help print photos,
banners, envelopes,
posters, and more.



From this tab: | You can change these settings:

Quality/Copies | Quality/Speed- Select a Quality/Speed setting.

Multiple Copies-Customize how the printer prints several photocopies of a single print
job: collated or normal.

Print Color Images in Black and White- Print your color images in black and white.
Paper Setup Type- Select the type of media you are using.
Paper Size- Select the size of the paper you are using.

Orientation- Select how you want the document oriented on the printed page. You can
print with portrait or landscape orientation.

Print Layout Layout- Select the layout you want to print.
Duplexing- Select this when you want to print on both sides of the paper.

E NOTE: For additional information about these settings, right-click a setting on the screen, and then
select the What's This? item.

Save Settings Menu

From the Save Settings menu, you can name and save the current Print Properties settings for future use.
You can save up to five custom settings.

Options Menu

Use the Options menu to make changes to the Quality, Layout, and Printing Status Options settings. For
more information on these settings, open the tab dialog box from the menu, and then click the Help button
located in the lower right corner of the screen.

The Options menu also provides you with direct links to different parts of the Dell Printer Solution Center, as
well as software version information.

Using the Dell Printer Solution Center

The Dell Printer Solution Center is a guide you can refer to for printer help and to check the current printer
status.

Access the Dell Printer Solution Center

Click Start - All Programs (or Programs) —» Dell Printers —» Dell AIO Printer A960 — Dell Printer
Solution Center.
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The following table describes the Dell Printer Solution Center tabs.

From this tab: You can:

Status (the tab that appears on Start) e Check the current printer status.
See what type of paper is in the printer.
View ink levels.

Receive information about basic features.
Receive scan, copy, fax, and print instructions.
Receive project information.

Search the electronic guide.

Go online to view more ideas.

How To

Troubleshooting Check the current printer status.
View recommended Help topics.
View common troubleshooting topics.

Search for more specific troubleshooting topics.




Contact Information
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Visit the support area online.

Learn how to install a new ink cartridge.

View information about how to purchase new ink cartridges.
Print a test page.

Clean the ink cartridge nozzles.

Align the ink cartridges.

Solve other problems.

Visit the supplies area online.

NOTE: Some links will not work while a job is in progress.

View information about ordering ink or supplies.

View information about contacting Dell Customer Support.
View a list of phone numbers.

Visit the Dell Web site.

Register your printer.

Change printing status appearance options.
View software version information.
Change the network printing settings.

Using Dell Picture Studio

E4 NOTE: Dell Picture Studio is included on your Driver and Utilities CD.

Dell Picture Studio lets you adjust photo attributes. With Dell Picture Studio, you can:

Eliminate red eye
Add text to images

Add special effects

Access Dell Picture Studio

Rotate images
Resize images

Create Web pages

Attach images to e-mail
Create and share slideshows

Make a series of images into a movie

e Click Start » All Programs (or Programs) — Dell Picture Studio —» Dell Picture Studio Home.



E NOTE: Your language may not be supported. If your language is not supported, use the photo editing
software in your Windows operating system.



Networking

A network is a group of devices connected to each other for the purpose of sharing information. Here is a
quick look at what you can do if you are considering using your printer across a network:

e Print from multiple computers if your printer is attached to a computer.

E

NOTE: All computers networked to the printer must be running either Windows XP or Windows 2000.

Copy using the operator panel.

Use the Print to fax feature. However, Fax Setup Utility functions are not available. Fax setup must be
done from the operator panel.

NOTE: You cannot use your printer to scan across a network.

Sharing Printers

You can print from multiple computers if your printer is attached to a computer that is connected to a
network.

Using Windows XP

First, follow these instructions while you are at your own computer.

Click Start - Control Panel - Printers and Other Hardware — Printers and Faxes.
Right-click the Dell AIO Printer A960 printer icon, and then click Sharing.
From the Sharing tab, click Share this printer, and then type a name in the Share name text box.

Click Additional Drivers and select the operating systems of all network clients printing to this
computer.

Click OK.

If you are missing files, you are prompted to insert the server operating system CD.

Make sure the printer object in the Printers folder shows that it is shared. For example, in Windows
2000, a hand is shown underneath the printer icon.

Browse Network Neighborhood. Find the host name of the server and look for the shared name you
assigned the printer.



Now, follow these instructions while you are at the other person's computer:

Click Start - Control Panel - Printers and Other Hardware — Printers and Faxes.
Click Add a printer to launch the Add Printer wizard.

Click Next.

Click Find a printer in the directory, and then click Next.

Click the Browse button to the right of location

Click the printer location, and then click OK.

Click Find Now.

Click the printer you want to connect to.

Click OK.

Print a test page to verify printer installation.

Click Start - Control Panel - Printers and Other Hardware —» Printers and Faxes.
Select the printer you just created.
Click File —» Properties.

From the General tab, click Print Test Page.

When a test page prints successfully, printer installation is complete.

Using Windows 2000

Click Start —» Settings —» Printers and Faxes or Printers.

Select the Dell AIO Printer A960 printer icon.

Click File Sharing.

Check the Shared as check box, and then type a name in the Shared Name text box.

Click Additional Drivers and select the operating systems of all network clients printing to this
computer.

Click OK.

If you are missing files, you are prompted to insert the server operating system CD.

Make sure the printer object in the Printers folder shows that it is shared. For example, in Windows
2000, a hand is shown underneath the printer icon.

Browse Network Neighborhood. Find the host name of the server and look for the shared name you
assigned the printer.



Now, follow these instructions while you are at the other person's computer:

Click Start —» Settings —» Printers and Faxes or Printers.

Click Add Printer to launch the Add Printer wizard.

Click Network Print Server.

Select the network printer from the Shared printers list. If the printer is not listed, type in the path of
the printer in the text box.

For example:\\<server host name>\<shared printer name>

The server host name is the name of the server computer that identifies it to the network. The shared
printer name is the name assigned during the server installation process.

Click OK.
If this is a new printer, you may be prompted to install a printer driver. If no system driver is
available, you will need to provide a path to available drivers.

Select whether you want this printer as the default printer for this client, and then click Finish.

Print a test page to verify printer installation.

Click Start » Settings —» Printers and Faxes or Printers.
Select the printer you just created.
Click File —» Properties.

From the General tab, click Print Test Page.

When a test page prints successfully, printer installation is complete.



Ink Cartridge Maintenance

@ Replacing Ink Cartridges

@ Aligning Ink Cartridges

Replacing Ink Cartridges

CAUTION: Before performing any of the procedures listed in this section, read and follow
the Safety Instructions on Notes, Notices, and Cautions.

Dell ink cartridges are available only through Dell. You can order more ink at www.dell.com/supplies.
1. Make sure the printer is on.

2. Lift the printer (scanner unit) until the scanner support keeps it open.

The ink cartridge carrier moves and stops at the loading position, unless the printer is busy.
3. Squeeze the tabs on the cartridge lids, and then lift the lids.
4. Remove the old cartridges. Store them in an air-tight container or dispose of them.

5. If you are installing new cartridges, remove the stickers and transparent tape from the bottom of the
cartridges.

0 NOTICE: Do not touch the gold contact area on the cartridges.

6. Insert the new cartridges. Make sure the black ink cartridge is secure in the left (black) cartridge
carrier and the color cartridge is secure in the right (blue) cartridge carrier, and then snap the lids
closed.

7. Lift the printer (scanner unit), and then push the scanner support to the right while lowering the
printer (scanner unit) until it is completely closed.

8. Load paper into the paper support.
9. Use the buttons on the operator panel to answer the questions that appear on the display:

a. If the color cartridge you installed is new (it has never been used), press Select.

If it is old (it has been used), press + once, and then press Select.

b. If the part number that appears is the number of the cartridge you are using, press Select.

If it is not the number of the cartridge you are using, press + until the correct part number
appears, and then press Select.



c. If the black cartridge you installed is new, press Select.

If it is old, press + once, and then press Select.
The part number that appears should be the number of the cartridge you are using.
d. Press Select to choose the part number that appears.

e. Continue with Aligning Ink Cartridges to ensure proper installation.

Aligning Ink Cartridges

Align your ink cartridges after installing new cartridges and to solve print quality problems.

Using the Operator Panel

1. Load plain paper. For help, see Loading Paper.
2. On the operator panel, press Copy.
3. Press Options until Mai nt enance appears.

4. Press + until Ali gn appears, and then press Select.
Al i gnment Page Printing appears on the display, and an alignment page prints. Once the alignment
page prints, your automatic alignment is complete.

Using the Printer Software to Automatically Align Ink
Cartridges

When automatically aligning your ink cartridges, a page prints with vertical, horizontal, and slanted lines.
1. Load paper. For help, see Loading Paper.

2. Click Start - All Programs (or Programs) — Dell Printers — Dell A10 Printer A960 — Dell
Printer Solution Center.

3. From the Maintenance tab, click Align to fix blurry edges.

4. Click Print.
An alignment page prints.

Using the Printer Software to Manually Align Ink Cartridges

When manually aligning your ink cartridges, a page prints with arrows followed by numbers.



Load paper. For help, see Loading Paper.

Click Start —» All Programs (or Programs) — Dell Printers —» Dell A10 Printer A960 —» Dell
Printer Solution Center.

From the Maintenance tab, click Align to fix blurry edges.

Click Manual Alignment, and then click Print.
An alignment page prints.

Find the number under the darkest arrow for each alignment group.

Use the arrows in the Align Cartridges dialog box to select the number that matches the arrow you
chose from the printed page.

Once you have selected a number for each of the alignment groups, click OK.



Troubleshooting

@ Setup Problems

@ General Problems

@ Error Messages And Flashing Lights

@ Improving Print Quality

@ More Troubleshooting Options

Setup Problems

If you experience problems while setting up your printer, make sure:

e You unlock the scanner bed by pushing the scanner lock down. For help locating the scanner lock, see
the picture of the printer on Understanding the Printer Parts.

e You select your language and default paper size, and then press Select on the operator panel.

If you skipped selecting your language, default country, date, time or fax number during the setup
process, see:

Display Language Is Not Preferable.

Default Country Was Not Set.

Fax Settings Are Unsatisfactory.

Date and Time On the Display Are Incorrect.

e You only have one Dell AIO Printer A960 attached to your computer.

e Your operating system is compatible with your printer. The Dell AIO Printer A960 supports Windows XP
and Windows 2000.

General Problems

Try to troubleshoot your problem before contacting Dell by checking the following items.

If your printer is not attached to a computer, make sure:
e You read and follow any scrolling text messages on the display.

e The power supply is plugged into your printer and an electrical outlet.



If your printer is attached to a computer, make sure:

The USB cable (sold separately) is securely attached to your computer and to your printer.
Both your computer and your printer are on.

The Dell AlO Printer A960 is set as your default printer.

Anytime your printer has a problem, make sure:

Your printer is on.
The scanner is unlocked. For help locating the scanner lock, see Scanner lock.

You removed the stickers and tape from the bottom of the ink cartridges. For help, see the Setup
Diagram.

The paper is loaded correctly. For help, see Loading Paper.

You installed both of the ink cartridges. The Dell AIO Printer A960 only works if you have both
cartridges installed. For help installing the cartridges, see the Setup Diagram.

Disconnect, and then reconnect both ends of the USB cable. For help, see the Setup Diagram.

Unplug the power supply from the electrical outlet. Reconnect the power supply (see the Setup
Diagram). Turn the power on.

Restart your computer. If problems persist, remove and then install the printer software. For help, see
Remove and Install the Software.

Document Does Not Print

Make sure the cartridges are properly installed.
Use an undamaged USB cable.

Check your printer status to make sure your document is not being held or paused. To check printer
status:

a. Start —» Control Panel - Printers and Other Hardware — Printers and Faxes (Windows
XP).
Click Start —» Settings — Printers and Faxes or Printers (Windows 2000).

b. Double-click the Dell AIO Printer A960 icon.

c. Click Printer., and make sure no check mark appears next to Pause Printing.

Print a test page:

a. Click Start -» All Programs (or Programs) — Dell Printers —» Dell A10 Printer A960
— Dell Printer Solution Center.



b. Click the Maintenance tab.

c. From the Maintenance tab, click Print a test page.

Document Prints Slowly

e Close programs not in use.

e Reduce the print quality resolution (Quick and Normal print more quickly than Better and Best).

E NOTE: Photos or documents containing graphics may take longer to print than regular text.

e Consider purchasing more Random Access Memory (RAM) for your computer.

Document Prints Poorly

Document Is Too Light or Too Dark

You can lighten or darken your document from the operator panel.
1. Press Copy or Fax from the Mode area.
1. On the operator panel, press Lighter/Darker.

2. Press + to darken your document or - to lighten it.

3. When the asterisk (*) on the display moves to a satisfactory position, press Select.

Vertical, Straight Lines Are Not Smooth

To improve the print quality of vertical, straight lines in tables, borders, and graphs:

e Test the cartridge alignment. For help, see Aligning Ink Cartridges.

e Clean the nozzles. For help, see Clean the Ink Cartridge Nozzles.

Characters Are Missing or Unexpected

Make sure the scanner glass is clean.
1. Dampen a clean lint-free cloth.

2. Gently wipe the scanner glass.



E NOTE: Make sure all ink or corrective fluid on the document is dry before placing the document on the
scanner glass.

Print Is Too Dark or Smudged

e Let the ink dry before handling the paper.
e Select the correct paper type and size in Preferences, Properties, or from the All-In-One Center.
e Make sure the paper is straight and unwrinkled.

e Select the appropriate Quality for the paper type. If you are printing on inkjet paper, select Quick Copy
from the Quality/Copies tab of Preferences, Properties, or from the All-In-One Center.

e Clean the cartridge nozzles. For help, see Clean the Ink Cartridge Nozzles.

Printed Pages Have Alternating Bands of Light and Dark Print
(Intermittent Printing)

If your document has alternating bands of light and dark print, you might need to select the highest print
quality.

1. With your document open, click File - Print.

2. In the Print dialog box, click Preferences or Properties (depending on your program or operating
system).

3. Select Best on the Quality/Copies tab.

Print Quality Is Poor at the Edges of the Page

Like other printers, the Dell Personal AIO Printer A960 cannot print in the extreme left, right, top, or bottom
edges of a page. Use these minimum settings:

e Left and right margins:
O 6.35 mm (0.25 inches) for all paper sizes except A4
o 3.37 mm (0.133 inches) for A4 size paper

e Top margin:
1.7 mm (0.067 inches)

e Bottom margin:
16.51 mm (0.65 inches)

Colors Are Faded or Not Printing Completely



e Check the ink level graphic on the Cartridges tab of the Printing Control Program.

e Use a different color setting.

Transparencies or Glossy Photo Papers Stick Together

e Remove each page as it exits the printer and let it dry completely before stacking.

e Use a transparency or photo paper designed for inkjet printers.

Transparencies or Photo Papers Contain White Lines

Clean the ink cartridge nozzles. For help, see Clean the Ink Cartridge Nozzles

Bl

ack and White Copy Quality Is Unsatisfactory

You might need to change an Advanced Copy Setting in the All-In-One Center.

If

1.

You Are Copying In Black and White and Want To Improve the Quality:

Click Start -» All Programs (or Programs) — Dell Printers —» Dell AI1O Printer A960 — Dell All-
In-One Center.

The All-In-One Main Page appears on your computer screen.

In the Copy section, click See More Copy Settings.

Click Advanced to display the Advanced Copy Settings dialog box.

Click the Scan tab.

From the Color depth drop down menu, select Gray.

Click OK.

Document Has a Checkerboard Pattern

Ify

ou scan or copy from a printed source and see a checkerboard pattern on your document, follow the

instructions below to eliminate the pattern.

For

1

scanning:

. Click Start —» All Programs (or Programs) — Dell Printers —» Dell A10 Printer A960 — Dell All-
In-One Center.
The All-In-One Main Page appears on your computer screen.



2. Click See More Scan Settings.

3. In the section for What is being scanned?, select Magazine.

4. Click Scan Now.

For copying:

1. Click Start —» All Programs (or Programs) — Dell Printers —» Dell A10 Printer A960 —» Dell All-
INn-One Center.

2. Click See More Copy Settings.
3. Click Display Advanced Copy Settings.
4. Select the Image Patterns tab.

5. Make sure the second box is checked to remove image patterns from magazine or newspaper
documents.

6. Click OK.

Edges of My Document Are Cut Off

If your document is cut off at the edges:
1. On the operator panel, press Copy or Fax.
2. Press Reduce/Enlarge.
3. Press +until Fit to Page appears.

4. Press Select.

Scanned Image Is Unsatisfactorily Cropped

You can turn auto-cropping off or adjust how the image is cropped.

To Turn Auto-cropping Off:

1. Click start —» All Programs (or Programs) — Dell Printers —» Dell AIO Printer A960 — Dell All-
INn-One Center.
The All-In-One Main Page appears on your computer screen.

2. Click See More Scan Settings.

3. Click Display Advanced Scan Settings.

4. Click Select area to be scanned, and then select a scan area from the drop-down menu.



5. Click OK.

To Adjust How The Image Is Cropped:

1. Click Start —» All Programs (or Programs) — Dell Printers —» Dell A10 Printer A960 —» Dell All-
INn-One Center.
The All-In-One Main Page appears on your computer screen.

2. Click See More Scan Settings.

3. Click Display Advanced Scan Settings.

4. Click the Scan tab.

5. Select Auto-crop the scanned item.

6. Slide the Tolerance bar to the left to crop less or to the right to crop more.

7. Click OK.

Scanner Unit Will Not Close

To close the scanner unit after installing ink cartridges, unlocking the scanner bed, or removing a paper jam,
follow these steps:

1. Using both hands, lift the scanner unit.
2. With one hand, push the scanner support to the side.

3. Hold the scanner support to the side as you lower the scanner unit.

ﬁ NOTE: Make sure the scanner unit closes completely.



Printer Is Scanning and Copying Without a Pre-Scan

E

On the operator panel, press Scan or Copy.

Press Options until ORI G NAL S| ZE appears.

Press Select to choose Auto Detect (default).
On the operator panel, press Reduce/Enlarge and then press + until Fit to Page appears.

Press Color or Black.

The scanner pre-scans your original document to determine its size, fits it onto the specified paper
size, and then scans your original document.

NOTE: Resizing an image may affect the scan and copy quality of your document.

Fax Does Not Work

In order for faxing to function properly:

The printer must be connected to an active phone line.

If you are using the printer software to fax, the printer must be connected to a computer with a USB
cable.

The memory may be full. Wait until the faxes in memory have been sent, and then send the current fax
again.

NOTE: You cannot fax with a DSL (digital subscribe line), ISDN (integrated signature digital network),
or cable modem.

For more information, see Faxing.

Printer is Not Sending or Receiving Faxes

If you are having trouble sending or receiving a fax through the printer software, ensure that:

Your computer is connected to a working data/fax modem.
An active phone line is connected to the line-in connector of your data/fax modem.
Fax software is installed and configured on your computer.

Your printer is connected to the computer with a USB cable.



Display Language Is Not Preferable

If the language on the printer display is not the language you prefer, change the language:
1. On the operator panel, press Options until Language displays.
2. Use + to scroll through the list of languages.

3. When your preferred language displays, press Select to set that language as the default.

Default Country Was Not Set

If you did not select the default country during the setup process:
1. Press Fax on the printer operator panel.
2. Press Options repeatedly until Advanced Fax appears on the display.
3. Press + repeatedly until Country code appears on the display, and then press Select.

4. Press + until your preferred your country appears on the display, and then press Select to set that
country as the default.

Fax Settings Are Unsatisfactory

1. Click start —» All Programs (or Programs) — Dell Printers —» Dell A1O Printer A960 — Dell
All-In-One Center.
The All-In-One Main Page appears on your computer screen.

2. In the upper left corner, click Maintain/Troubleshoot.

3. Under Fax Setup Utility, click Display the Fax Setup Utility.

4. Adjust the settings you want to change.

5. Click Save Settings.

Date and Time On the Display Are Incorrect

To set the current date and time:
1. On the operator panel, press Fax.
2. To change the date:

a. Press Options until EDI T DATE/ Tl ME: appears on the display.



b. Press Select.

c. Use the keypad buttons to enter the date you want your printer to display.

d. Press Select.

E NOTE: If the date is entered incorrectly, the date shown will be the default.

3. To change the time:

a. Press Options until EDI T DATE/ Tl ME: appears on the display.

b. Press + once, and then press Select.
c. Use the keypad buttons to enter the time you want your printer to display.
d. Press Select.

e. Press 1 for AM, 2 for PM, or 3 for 24-hour time.
E NOTE: If the time is entered incorrectly, the time shown will be the default.

Paper Misfeeds or Multiple Sheets Feed

e Use a paper recommended for inkjet printers.
e Do not force the paper into the printer.
e Do not load too much paper into the printer. For help, see Loading Paper.

e Make sure the paper guide rests against the left edge of the paper and does not cause the paper to
bow in the paper support.



e Place the printer on a flat, level surface.

e Select the correct paper type and size.

Paper Jams

If a paper jam occurs in the paper support, remove the paper from the printer. If the paper is lodged too far
into the printer and cannot be removed:

1. Press Power to turn the printer off.

2. Pull slowly and firmly on the paper to remove it.

If you cannot reach the paper because it is too far into the printer:

a. Lift the scanner unit, and then pull the paper out.



b. Lower the scanner unit to close it.

3. Press Power to turn the printer on, and then print your document.

Document Misfeeds or Jams

1. Turn the printer off.

2. Open the ADF.



3. Pull gently to remove the paper jam.

4. Close the ADF.
5. Turn the printer on.

6. Print any missing pages.

Error Messages And Flashing Lights

Use this section to understand printer software error messages on your computer screen or operator panel
display and blinking lights on your printer.

Ink Low Message

An ink cartridge is running out of ink. The Ink Low warning occurs when your cartridges are about 25% full,
15% full, and 5% full. When one of these messages appears, you can:

e Click OK.
e Click the ? to get information about ordering supplies.

e Order a new cartridge from Dell at www.dell.com/supplies.

For help installing a new cartridge, see Replacing Ink Cartridges.

Paper Jam Message

If your printer has a paper jam:

1. Click Start —» All Programs (or Programs) — Dell Printers —» Dell A10O Printer A960 —» Dell
Printer Solution Center.

2. Click the Troubleshooting tab on the left side of the screen.



3. Click How to clear and avoid paper jams.

4. Follow the instructions to clear the paper jam.

Paper Out Message

If your printer is out of paper, Load paper then press Sel ect appears on the display.
1. Follow these instructions to clear the message from the display.

2. Print your document.

Hardware Error: 0402

The printer has a paper jam in the ADF. See Document Misfeeds or Jams to clear the jam.

Hardware Error: 401

The printer scanner is stalled.
1. Press Power to turn your printer off.
2. Unplug your printer.
3. Make sure the scanner is unlocked.
4. Plug in your printer.

5. Press Power to turn your printer on.

Cartridge Error: 50C

Your ink cartridge has a short.
1. Press Power to turn your printer off.
2. Unplug your printer.
3. Plug in your printer.
4. Turn your printer on.

5. Uninstall and reinstall the cartridges.



"4 NOTE: If this does not resolve the problem, see More Troubleshooting Options or replace your

cartridges.
Hardware Error: 502

The printer is stalled.
1. Press Power to turn your printer off.
2. Unplug your printer.
3. Check for paper jams.
4. Plug in your printer.

5. Press Power to turn your printer on.

Power Light Blinks Twice

The ink cartridge carrier might be stalled. Check your computer screen for error messages.

1. Turn the printer off.

2. Wait a few seconds, and then turn the printer on.

Improving Print Quality

If you are not satisfied with the print quality of your document, make sure you:
e Use the appropriate paper for the document.

e Use paper that is a heavier weight, bright white, or coated. Use Dell™ Premium Photo Paper for
printing photos.

e Select a higher print quality:

a. From your software program, click File » Print.

The Print dialog box appears.
b. From the Print dialog box, click Preferences or Properties.

c. From the Quality/Speed area, select Better or Best.



If your document still does not have the print quality you want, follow these steps:

Reinsert the Ink Cartridges

1.

2.

3.

4.

Remove the ink cartridges.
Insert the ink cartridges.
Print your document again.

If print quality has not improved, continue with Clean the Ink Cartridge Nozzles.

Clean the Ink Cartridge Nozzles

Clean the nozzles when:

To

1.

To

1.

2.

Characters are not printing completely

White dashes appear in graphics or printed text.

Print is smudged or too dark.

Colors on print jobs are faded or they differ from the colors on the screen.

Vertical, straight lines are not smooth.

Clean the Nozzles Using the Operator Panel

Load paper in the printer. For help, see Loading Paper.
Press Copy.

Press Options until Mai nt enance appears on the display.
Press + until Cl ean appears on the display.

Press Select.
A nozzle page prints, forcing ink through the clogged nozzles to clean them.

Print your document again to verify that your print quality has improved.

If you are not satisfied with the print quality, continue with Wipe the Ink Cartridge Nozzles and
Contacts, and then print your document again.

Clean the Nozzles Using the Printer Software

Load paper. For help, see Loading Paper.

Click Start —» All Programs (or Programs) — Dell Printers —» Dell A10O Printer A960 —» Dell
Printer Solution Center.



3. From the Maintenance tab, click Clean to fix horizontal streaks.

4. Click Print.
A nozzle page prints, forcing ink through the nozzles to clean the clogged nozzles.

5. Print your document again to verify that your print quality has improved.

6. If you are not satisfied with the print quality, continue with Wipe the Ink Cartridge Nozzles and
Contacts, and then print your document again.

Wipe the Ink Cartridge Nozzles and Contacts

1. Remove the ink cartridges.
2. Dampen a clean, lint-free cloth with water.

3. Gently hold the cloth against the nozzles for about three seconds, and then wipe in the direction
shown.

Il cartridpe mo=l=s

4. Using another clean section of the cloth, gently hold the cloth against the contacts for about three
seconds, and then wipe in the direction shown.

Ink gartride contacts

5. With another clean section of the cloth, repeat steps 3 through 4.



10.

11.

Let the nozzles and contacts dry completely.

Reinsert the ink cartridges.

Clean the print nozzles. For help, see Clean the Ink Cartridge Nozzles.

Print your document again.
If the print quality does not improve, repeat step 8 up to two more times.

If print quality is still not satisfactory, replace the ink cartridges. For information, see your Owner's
Manual.

Remove and Install the Software

If the printer is not functioning properly or if a communications error message appears when you try to use
your printer, you may need to remove the printer software, and then reinstall it.

1.

Click Start - All Programs (or Programs) — Dell Printers —» Dell AI1O Printer
A960 — Uninstall Dell A10O Printer A960.

Follow the instructions on your screen to remove the printer software.
Restart your computer before reinstalling the printer software.

Insert the Driver and Utilities CD, and then follow the instructions on your screen to install the
software.

More Troubleshooting Options

If the preceding solutions do not solve the problem you are having with your printer:

e See the Dell Printer Solution Center software for more troubleshooting information:

a. Click Start -» All Programs (or Programs) — Dell Printers —» Dell A1O Printer
A960 — Dell Printer Solution Center.

b. Click the Troubleshooting tab on the left side of the screen.

e Go to support.dell.com for help.
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@ Overview @ Print And Scan Mode Capabilities
@ Physical Specifications @ Operating System Support
@ Environmental Specifications @ Memory Specifications and

Requirements

@ Ppower Consumption And @ paper
Requirements
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Overview

Base memory 16 MB

Maximum memory 17 MB

Emulation Host based data stream printing

Connectivity USB

Duty cycle (average) 3000 pages/month

Duty cycle (maximum) 5000 pages/month

Printer life 36000 pages or one year (Letter size 5% coverage)

Physical Specifications

Physical dimension 332.58mm (H) x 499.5mm (W) x 520.7mm (D)
12.7 in. (H) x 19.7 in. (W) x 20.5 in. (D)
Weight 11.3 kg
2493 Ib

Environmental Specifications

Temperature/Relative Humidity



Condition | Temperature | Relative humidity (non-condensing)

Operation | 16° to 32° C 15 to 85%
61° to 90° F

Storage -40° to 60° C | 10 to 90%
-40° to 140° F

Shipping -40° to 60° C
-40° to 140° F

The recommended temperature and relative humidity for all conditions 61° to 90° F | 40 to 70%

Power Consumption And Requirements

Rated AC Input 100V-240V
Rated Frequency 50/60 Hz
Minimum AC input 100V AC
Maximum AC input 240V AC
Maximum input current 1.5A
Average power consumption <15W
<35W

Standby mode
Operational mode

Fax Mode Capabilities

When you scan to fax, your document will scan in at 100 dpi (dots per inch). You can fax both color and
black and white documents. You can also fax multiple pages. For help, see Send Multiple Page Faxes.

In order for faxing to function properly:
e The printer must be connected to an active phone line.

e If you are using the printer software to fax, the printer must be connected to a computer with a USB
cable.

ﬁ NOTE: You cannot fax with a DSL (digital subscribe line), ISDN (integrated signature digital network),
or cable modem.

ﬁ NOTE: You can also use the Fax Utility Software (see Access the Fax Setup Utility) to adjust some of
the printer fax settings.




Print And Scan Mode Capabilities

Your Dell AIO Printer A960 can scan from 50 to 19,200 dpi. Even though your All-In-One has this capability,

we recommend using the preset resolutions.

Print and scan resolution dpi Equivalent print resolution
Quick 150 x 150 | 600 x 300 dpi

Normal 300 x 300 | 600 x 600 dpi

Better 600 x 600 | 1200 x 1200 dpi

Best 600 x 600 | 4800 x 1200 dpi

Operating System Support

The Dell AIO Printer A960 supports:
Windows XP

Windows 2000

Memory Specifications and Requirements

Your operating system must meet the minimum system requirements.

Operating system | Processor speed (Mhz) | RAM (MB) | Hard disk (MB)

Virtual memory (MB)

Windows XP Pentium 300 128 500 300
Windows 2000 Pentium 200 128 286 286
Paper

See Print Media Guidelines for the Paper Support or Print Media Guidelines for the ADF for information on

what paper sizes and types are supported with your Dell All-In-One Printer A960.




Cables

Your Dell AIO Printer A960 uses a Universal Serial Bus (USB) cable (sold separately).
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Appendix

@ Dell Technical Support Policy

@ cContacting Dell

@ warranty and Return Policy

Dell Technical Support Policy

Technician-assisted technical support requires the cooperation and participation of the customer in the
troubleshooting process and provides for restoration of the Operating System, application software and
hardware drivers to the original default configuration as shipped from Dell, as well as the verification of
appropriate functionality of the computer unit and all Dell-installed hardware. In addition to this technician
assisted technical support, online technical support is available at Dell Support. Additional technical support
options may be available for purchase.

Dell provides limited technical support for the printer and any Dell-installed software and peripherals.
Support for third-party software and peripherals is provided by the original manufacturer, including those
purchased and/or installed through Software & Peripherals (DellWare), ReadyWare, and Custom Factory
Integration (CFI/DellPlus).

Contacting Dell

You can access Dell Support at support.dell.com. Select your region on the WELCOME TO DELL SUPPORT
page, and fill in the requested details to access help tools and information.

You can contact Dell electronically using the following addresses:

e World Wide Web
www.dell.com/
www.dell.com/ap/ (for Asian/Pacific countries only)
www.euro.dell.com (for Europe only)
www.dell.com/la/ (for Latin American countries)

e Anonymous file transfer protocol (FTP)
ftp.dell.com/
Log in as user: anonymous, and use your e-mail address as your password.

e Electronic Support Service
mobile_support@us.dell.com
support@us.dell.com
apsupport@dell.com (for Asian/Pacific countries only)
support.euro.dell.com (for Europe only)

e Electronic Quote Service
sales@dell.com
apmarketing@dell.com (for Asian/Pacific countries only)



e Electronic Information Service
info@dell.com

Warranty and Return Policy

Dell Inc. ("Dell") manufactures its hardware products from parts and components that are new or equivalent
to new in accordance with industry-standard practices. For information about the Dell warranty for your
printer, refer to your Owner's Manual.



Notices
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Telecommunications Act 1984

@ NOM Information (Mexico Only) @ Mercury Statement

@ ENERGY STAR® Compliance @ Copyright Advisory

@ Notice to users of the Canadian
telephone network

Regulatory Notices

Electromagnetic Interference (EMI) is any signal or emission, radiated in free space or conducted along power or signal
leads, that endangers the functioning of a radio navigation or other safety service or seriously degrades, obstructs, or
repeatedly interrupts a licensed radio communications service. Radio communications services include but are not
limited to AM/FM commercial broadcast, television, cellular services, radar, air-traffic control, pager, and Personal
Communication Services (PCS). These licensed services, along with unintentional radiators such as digital devices,
including computers, contribute to the electromagnetic environment.

Electromagnetic Compatibility (EMC) is the ability of items of electronic equipment to function properly together in the
electronic environment. While this computer has been designed and determined to be compliant with regulatory
agency limits for EMI, there is no guarantee that interference will not occur in a particular installation. If this
equipment does cause interference with radio communications services, which can be determined by turning the
equipment off and on, you are encouraged to try to correct the interference by one or more of the following measures:
- Reorient the receiving antenna.

- Relocate the computer with respect to the receiver.

- Move the computer away from the receiver.

- Plug the computer into a different outlet so that the computer and the receiver are on different branch circuits.

If necessary, consult a Dell Technical Support representative or an experienced radio/television technician for
additional suggestions.

FCC Notices (U.S. Only)



Most Dell computers are classified by the Federal Communications Commission (FCC) as Class B digital devices. To
determine which classification applies to your computer, examine all FCC registration labels located on the bottom,
side, or back panel of your computer, on card-mounting brackets, and on the cards themselves. If any one of the
labels carries a Class A rating, your entire computer is considered to be a Class A digital device. If all labels carry an
FCC Class B rating as distinguished by either an FCC ID number or the FCC logo, (FG ), your computer is considered
to be a Class B digital device.

Once you have determined your computer's FCC classification, read the appropriate FCC notice. Note that FCC
regulations provide that changes or modifications not expressly approved by Dell could void your authority to operate
this equipment.

This device complies with Part 15 of the FCC Rules. Operation is subject to the following two conditions:

- This device may not cause harmful interference.
- This device must accept any interference received, including interference that may cause undesired operation.

Class B

This equipment has been tested and found to comply with the limits for a Class B digital device pursuant to Part 15 of
the FCC Rules. These limits are designed to provide reasonable protection against harmful interference in a residential
installation. This equipment generates, uses, and can radiate radio frequency energy and, if not installed and used in
accordance with the manufacturer's instruction manual, may cause interference with radio communications. However,
there is no guarantee that interference will not occur in a particular installation. If this equipment does cause harmful
interference to radio or television reception, which can be determined by turning the equipment off and on, you are
encouraged to try to correct the interference by one or more of the following measures:

- Reorient or relocate the receiving antenna.

- Increase the separation between the equipment and the receiver.

- Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
- Consult the dealer or an experienced radio/television technician for help.

FCC ldentification Information

The following information is provided on the device or devices covered in this document in compliance with FCC
regulations:

- Model number:
- Company name:

Dell Inc.

One Dell Way

Round Rock, Texas 78682 USA
512-338-4400

Modem Regulatory Information

This equipment complies with Part 68 of the FCC Rules. On the bottom of your computer is a label that contains,
among other information, the FCC registration number and ringer equivalence number (REN) for your equipment. If
requested, you must provide this information to the telephone company.

The REN is used to determine the quantity of devices that may be connected to the telephone line. Excessive RENs on
the telephone line may result in the devices not ringing in response to an incoming call. In most areas, the sum of all
the RENs on your telephone line should be less than five to ensure proper service from the telephone company. To be
certain of the number of devices that you may connect to a line, as determined by the total RENs, contact your local
telephone company.

The registration jack Universal Service Order Code (USOC) used by this equipment is RJ-11C. An FCC compliant
telephone cord and modular plug is provided with this equipment. This equipment is designed to be connected to the
telephone network or premises wiring using a compatible modular jack that is Part 68 compliant.



This equipment cannot be used on public coin-phone service provided by the telephone company. Connection to party
line service is subject to state tariffs.

There are no user serviceable parts on the modem contained in your computer.

If your telephone equipment causes harm to the telephone network, the telephone company will notify you in advance
that service may be temporarily discontinued. If advance notice is not practical, the telephone company will notify you
as soon as possible. Also, you will be advised of your right to file a complaint with the FCC if you believe it is
necessary.

The telephone company may make changes in its facilities, equipment, operations, or procedures that could affect the
operation of this equipment. If this happens, the telephone company will provide advance notice in order for you to
make necessary modifications to maintain uninterrupted service.

If you experience trouble with this telephone equipment, see "Getting Help" in your computer's troubleshooting
documentation or, for some computers, the section titled "Contacting Dell" in your computer's online guide to find the
appropriate telephone number for obtaining customer assistance. If the equipment is causing harm to the telephone
network, the telephone company may request that you disconnect the equipment until the problem is resolved.

Fax Branding

The Telephone Consumer Protection Act of 1991 makes it unlawful for any person to use a computer or other
electronic device, including fax machines, to send any message unless such message clearly contains in a margin at
the top or bottom of each transmitted page or on the first page of the transmission, the date and time it is sent,
identification of the business, other entity, or individual sending the message, and the telephone number of the
sending machine or such business, other entity, or individual. The telephone number provided may not be a 900
number or any other number for which charges exceed local or long-distance transmission charges.

IC Notice (Canada Only)

Most Dell computers (and other Dell digital apparatus) are classified by the Industry Canada (IC) Interference-Causing
Equipment Standard #3 (ICES-003) as Class B digital devices. To determine which classification (Class A or B) applies
to your computer (or other Dell digital apparatus), examine all registration labels located on the bottom, side, or the
back panel of your computer (or other digital apparatus). A statement in the form of "IC Class A ICES-003" or "IC
Class B ICES-003" will be located on one of these labels. Note that Industry Canada regulations provide that changes
or modifications not expressly approved by Dell could void your authority to operate this equipment.
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Modem Regulatory Information

The IC label identifies certified equipment. This certification means that the equipment meets telecommunications
network protective, operational, and safety requirements as prescribed in the appropriate Terminal Equipment
Technical Requirements document(s). The IC label does not guarantee that the equipment will operate to the user's
satisfaction.

Before installing this equipment, users should ensure that it is permissible to be connected to the facilities of the local
telecommunications company. The equipment must also be installed using an acceptable method of connection. The
customer should be aware that compliance with the above conditions may not prevent degradation of service in some
situations.



Repairs to certified equipment should be coordinated by a representative designated by the supplier. Any repairs or
alteration made by a user to this equipment, or equipment malfunctions, may give the telephone communications
company cause to request the user to disconnect the equipment.

Users should ensure for their own protection, that the electrical ground connections of the power utility, telephone
lines, and internal metallic water-pipe system, if present, are connected together. This precaution may be particularly
important in rural areas.

Q NOTICE: Users should not attempt to make such connections themselves. Contact the appropriate
electric inspection authority, or electrician, as appropriate.

NOTE: The REN assigned to each terminal device provides an indication of the maximum number of terminals allowed
to be connected to a telephone interface. The termination on an interface may consist of any combination of devices
subject only to the requirement that the sum of the RENs of all the devices does not exceed the number five.

The REN for the internal modem as stated on the IC regulatory label located on the bottom of the computer is 0.6 B.
The following information is provided in compliance with IC regulations:

Dell Inc.

One Dell Way

Round Rock, TX 78682 USA
512-338-4400

CE Notice (European Union)

Marking by the symbol ce indicates compliance of this Dell computer to the EMC Directive and the Low Voltage
Directive of the European Union. Such marking is indicative that this Dell system meets the following technical
standards:

- EN 55022 - "Information Technology Equipment - Radio Disturbance Characteristics - Limits and Methods of
Measurement."

- EN 55024 - "Information Technology Equipment - Immunity Characteristics - Limits and Methods of Measurement."

- EN 61000-3-2 - "Electromagnetic Compatibility (EMC) - Part 3: Limits - Section 2: Limits for Harmonic Current
Emissions (Equipment Input Current Up to and Including 16 A Per Phase)."

- EN 61000-3-3 - "Electromagnetic Compatibility (EMC) - Part 3: Limits - Section 3: Limitation of Voltage Fluctuations
and Flicker in Low-Voltage Supply Systems for Equipment With Rated Current Up to and Including 16 A."

- EN 60950 - "Safety of Information Technology Equipment.”
NOTE: EN 55022 emissions requirements provide for two classifications:

- Class A is for typical commercial areas.
- Class B is for typical domestic areas.

RF INTERFERENCE WARNING: This is a Class A product. In a domestic environment this product may
cause radio frequency (RF) interference, in which case the user may be required to take adequate
measures.

This Dell device is classified for use in a typical Class B domestic environment.

A "Declaration of Conformity" in accordance with the preceding directives and standards has been made and is on file
at Dell Inc. Products Europe BV, Limerick, Ireland.

CE Mark Notice

This equipment complies with the essential requirements of the European Union Directive 1999/5/EC.
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NOM Information (Mexico Only)

The following information is provided on the device(s) described in this document in compliance with the requirements
of the official Mexican standards (NOM):

Exporter: Dell Inc.
One Dell Way
Round Rock, TX 78682

Importer: Dell Computer de México, S.A. de C.V.
Paseo de la Reforma 2620 - 11° Piso
Col. Lomas Altas

11950 México, D.F.

Ship to: Dell Computer de México, S.A. de C.V.

al Cuidado de Kuehne & Nagel de México S. de R.L.
Avenida Soles No. 55

Col. Pefion de los Bafios

15520 México, D.F.

Model number:

Supply voltage: 100/240 VAC
Frequency: 50/60 Hz
Current Consumption: 1.5A

Output voltage: 20 vDC

Output current: 3.5A




ENERGY STAR® Compliance

Certain configurations of Dell computers comply with the requirements set forth by the Environmental Protection
Agency (EPA) for energy-efficient computers. If the front panel of your computer bears the ENERGY STAR® Emblem,
your original configuration complies with these requirements and all ENERGY STAR® power management features of
the computer are enabled.

Any Dell computer bearing the ENERGY STAR® Emblem is certified to comply with EPA ENERGY STAR® requirements
as configured when shipped by Dell. Any changes you make to this configuration (such as installing additional
expansion cards or drives) may increase the computer's power consumption beyond the limits set by the EPA's
ENERGY STAR® Computers program.

ENERGY STAR® Emblem

g

The EPA's ENERGY STAR® Computers program is a joint effort between the EPA and computer manufacturers to
reduce air pollution by promoting energy-efficient computer products. The EPA estimates that use of ENERGY STAR®
computer products can save computer users up to two billion dollars annually in electricity costs. In turn, this
reduction in electricity usage can reduce emissions of carbon dioxide, the gas primarily responsible for the greenhouse
effect, and sulfur dioxide and nitrogen oxides, the primary causes of acid rain.

You can also help reduce electricity usage and its side effects by turning off your computer when it is not in use for
extended periods of time, particularly at night and on weekends.

Notice to users of the Canadian telephone network

This product meets the applicable Industry Canada technical specifications.

The Ringer Equivalence Number (REN) is an indication of the maximum number of terminals allowed to be connected
to a telephone interface. The terminus of an interface may consist of any combination of devices, subject only to the
requirement that the sum of the Ringer Equivalence Numbers of all the devices does not exceed five. The modem REN
is located on the rear of the equipment on the product labeling.

Telephone companies report that electrical surges, typically lightning transients, are very destructive to customer
terminal equipment connected to AC power sources. This has been identified as a major nationwide problem. It is
recommended that the customer install an AC surge arrestor in the AC outlet to which this device is connected. This is
to avoid damage to the equipment caused by local lightning strikes and other electrical surges.

This equipment uses CA11A telephone jacks.

Using the Dell A960 in Germany

The Dell A960 printer requires a German billing tone filter to be installed on any line which receives metering pulses in
Germany. Metering pulses may or may not be present on analog lines in Germany. The subscriber may request that
metering pulses be placed on the line, or can have them removed by calling the German network provider. Normally,
metering pulses are not provided unless specifically requested by the subscriber at the time of installation.




Using the Dell A960 in Switzerland

The Dell A960 printer requires a Swiss billing tone filter to be installed on any line which receives metering pulses in
Switzerland. The filter must be used, as metering pulses are present on all analog telephone lines in Switzerland.

The Dell A960 has been tested and found to comply with the limits for a Class B digital device, pursuant to Part 15 of
the FCC Rules. Operation is subject to the following two conditions: (1) this device may not cause harmful
interference, and (2) this device must accept any interference received, including interference that may cause
undesired operation.

The FCC Class B limits are designed to provide reasonable protection against harmful interference in a residential
installation. This equipment generates, uses and can radiate radio frequency energy and, if not installed and used in
accordance with the instructions, may cause harmful interference to radio communications. However, there is no
guarantee that interference will not occur in a particular installation. If this equipment does cause harmful interference
to radio or television reception, which can be determined by turning the equipment off and on, the user is encouraged
to try to correct the interference by one or more of the following measures:

- Reorient or relocate the receiving antenna.

- Increase the separation between the equipment and receiver.

- Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
- Consult your point of purchase or service representative for additional suggestions.

The manufacturer is not responsible for any radio or television interference caused by using other than recommended
cables or by unauthorized changes or modifications to this equipment. Unauthorized changes or modifications could
void the user's authority to operate this equipment.

NOTE: To assure compliance with FCC regulations on electromagnetic interference for a Class B computing device, use
a properly shielded and grounded cable. Use of a substitute cable not properly shielded and grounded may result in a
violation of FCC regulations.

Any questions regarding this compliance information statement should be directed to:
Dell Products, L.P.

One Dell Way
Round Rock, Texas 78682

Industry Canada Compliance Statement

This Class B digital apparatus meets all requirements of the Canadian Interference-Causing Equipment Regulations.

Avis De Conformité Aux Normes De L'industrie Du Canada

Cet appareil numérique de la classe B respecte toutes les exigences du Réglement sur le matériel brouilleur du
Canada.

European Community (EC) directives conformity

This product is in conformity with the protection requirements of EC Council directives 89/336/EEC, 73/23/EEC, and
1999/5/EC on the approximation and harmonization of the laws of the Member States relating to electromagnetic
compatibility and safety of electrical equipment designed for use within certain voltage limits and on radio equipment
and telecommunications terminal equipment.

A declaration of conformity with the requirements of the directives has been signed by the Director of Manufacturing
and Technical Support, Lexmark International, S.A., Boigny, France.

This product satisfies the Class B limits of EN 55022 and safety requirements of EN 60950.



The United Kingdom Telecommunications Act 1984

This apparatus is approved under the approval number NS/G/1234/3/100003 for the indirect connections to the public
telecommunications systems in the United Kingdom.

Mercury Statement

This product contains mercury in the lamp (<5mg Hg). Disposal of mercury may be regulated due to environmental
considerations. For disposal or recycling information, contact your local authorities or the Electronic Industries
Alliance: www.eiae.org.

Copyright Advisory

It may be illegal to copy certain materials without permission or license, including documents, images, and currency.
If you are not sure whether you have permission, seek legal advice.
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